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Launching Excel 
When you launch the application, a workbook opens automatically.  An Excel workbook is made of several sheets. Unless you have changed the default setting, you will have three sheets. 

[image: excel_sheet_control]
[bookmark: _Toc318889798]Figure 1: Excel Workbook Sheets

Changing the name of the worksheets 
Each sheet is a full spreadsheet.  Having a workbook with multiple sheets allows you to easily establish relationships from one sheet to another.

The name of the sheet may be changed.  Double-click the name of the sheet or right click and select Rename, and type the new name.

[image: excel_sheet_name]
[bookmark: _Toc318889799]Figure 2: Change Name of Worksheet

[image: ]Inserting additional worksheets[bookmark: _Toc318889707][bookmark: _Toc318889800]Figure 3: Insert Worksheet in Excel

If you need additional worksheets, you may also insert a worksheet by right-clicking on any existing sheet name and selecting Insert…  Additionally, you can click on the Insert Worksheet tab located at the far right of the named tabs, or by hitting Shift and the F11 key simultaneously.

[image: ]

Cells 
Rectangles in a spreadsheet are called cells.  Cells are designated by the intersection of the lettered column (vertical) and numbered row (horizontal) in which it is located.  By default, the top left cell, A1, is highlighted.  Depending on the default settings, columns may also be numbered.  To turn off this setting, click the Microsoft Office Button (or the [image: ] tab in Excel 2010), and then click Excel Options.  Click Formulas, and then, under Working with formulas, clear the R1C1 reference style check box. 

[bookmark: _Toc318889801]Figure 4: Excel Options- Working with Formulas
[bookmark: move]Try the following ways to move from cell to cell:
Hit the Return/Enter key to move down to the row below. 
Hold down the Shift key, then hit the Return/Enter key to move up to the row above. 
Hit the Tab key to move over to the column to the right. 
Hold down the Shift key; hit the Tab key to move back to the column to the left. 
Move the cursor to any cell and click there. 
Use the arrow keys to move up, down, left, or right. 
[bookmark: cursor]Recognizing cursor styles
There are four common cursor styles used in Excel.
	
	Click and drag to highlight multiple cells with this cursor, or click in a cell to select the single cell.
	
	
	Click and drag with this cursor to fill cell contents or patterns into cells below or to the right.

	
	
	
	
	

	
	Click and drag the contents of the selected cell to any other cell.
	
	
	Click to place the cursor into the Formula Bar so that you can edit an equation or function.


[bookmark: _Toc318889802]Figure 5: Excel Cursor Styles
Entering data
Move to the cell where you want to enter data, and enter words or numbers.  If data is already in the cell, then it will be replaced without your having to cut or delete the previous data.
[bookmark: _Toc274226491]

[bookmark: _Toc318889782]Understanding Menus
Overview of Menu Options 
Excel 2007/10 has moved toward a more intuitive graphic menu, eliminating the text menus and toolbars in previous versions.

Instead, most Excel configurations now feature eight tabbed menus, plus a Microsoft Office Button for file management tasks and a help button.

Home Tab
This tab covers clipboard functions (Copy, Paste, etc.), most common formatting options, and the most commonly used filtering options.

[bookmark: _Toc318889710][bookmark: _Toc318889803]Figure 6: Microsoft Excel Home Tab


Clicking on the small downward arrow next to many options will show a list of the most commonly used choices.  For example, clicking on the formatting tab will show the most common data formats (e.g., number, currency, date, etc.)


[bookmark: _Toc318889804]Figure 7: Excel 07/10 Home Tab Options

For certain modules, a more in-depth menu can be accessed by clicking on the bottom right of the module name.


[bookmark: _Toc318889805]Figure 8: Excel 03 Home Tab Variations
The menu will look familiar to those who have used Excel 2003 or earlier.  Most information shown is also shown in the visual menu, but certain options can only be easily accessed in this view.  For example, creating Superscript or Strikethrough text can only be easily set in this menu.  Generally, each tab in this text menu will correspond to one of the modules shown in the visual menu, although they usually do not match exactly.

[bookmark: _Toc318889713][bookmark: _Toc318889806]Figure 9: Excel 03 Options



[bookmark: _Toc179803619]
Insert Tab
This tab allows the user to insert a wide range of objects and graphics into the workbook, ranging from pivot charts, pictures & clip art, static charts, hyperlinks, text boxes, embedded objects, and symbols.


[bookmark: _Toc318889807]Figure 10: Insert Tab

As with the Home Tab, clicking on the small arrow at the bottom right of the Charts module will show the detailed chart menu, with a broader range of options and tools.


[bookmark: _Toc318889808]Figure 11: Excel 03 Insert Options



Page Layout Tab
This tab contains most options for controlling the general look of the worksheet, such as selecting layout themes, changing view and print options, and modifying how data appears on the sheet.  Note that changes to these visual themes will impact the formatting options displayed on other menus.


[bookmark: _Toc318889809]Figure 12: Page Layout Tab

Once again, clicking on the small arrows will open a Page Layout menu familiar to Excel 2003 users.


[bookmark: _Toc318889810]Figure 13: Excel 03 Page Setup Options



Formula Tab
This tab allows the user to insert functions, define and name ranges of data, audit formulas, and change calculation options.  


[bookmark: _Toc318889811]Figure 14: Formulas Tab

For the Function Library, a text menu can be accessed by clicking the drop down on any function menu and clicking on the Insert Function option.



The resulting menu will look familiar to Excel 2003 users.


[bookmark: _Toc318889812]Figure 15: Excel 03 Insert Function Options

Data Tab
This tab allows the user to link the workbook to external data, share data with other users, filter data (same as Home Tab), add outlining features, and perform various analytical operations. 


[bookmark: _Toc318889813]Figure 16: Data Tab

Review Tab
This tab allows the user to review and control the modification of data.  In particular, it features editing tools, like the Spell Check; the option to add and modify comments; and the ability to set protection and sharing options.  


[bookmark: _Toc318889814]Figure 17: Review Tab

View Tab 
This tab allows the user to control the general look of Excel and the presentation of information.  The user can change the type of view, add or remove gridlines (same as Page Layout Menu), zoom in or out, and change the appearance of windows.  Additionally, this menu allows the user to create and edit Macros.  Macro security options can be found under the Microsoft Office Button (or the [image: ] tab in Excel 2010).


[bookmark: _Toc318889815]Figure 18: View Tab



Acrobat Tab
This menu allows the user to create Adobe PDF documents.

Microsoft Office Button   or File Tab (Excel 2010)   
The primary purpose of this button/tab is for file management, allowing the user to save, open, print, set security options, or send documents via email or the internet.
 
	
[bookmark: _Toc318889816]Figure 19: Excel 2007 MS Office Button
	
[bookmark: _Toc318889817]Figure 20: Excel 2010 File Tab

	
	


Additionally, clicking the Excel Options button will open a menu that allows the users to set the global options for Excel (see the figure below).   Essentially, this sets the default for how Excel looks, operates, and functions.  Most of these settings can be modified in other menus, but each new workbook will revert to these default options.

[bookmark: _Toc318889818]Figure 21: Excel Options

Help Button 
This button allows the user to launch the Help Function – Click on the blue question mark near the top right of the screen.


[bookmark: _Toc318889819]Figure 22: Help Button



The resulting menu allows the user to look through the list of help topics or use the search bar to search for a specific topics, formulae, or problems. 


[bookmark: _Toc318889820]Figure 23: Excel Help Menu
Minimize Ribbon (Excel 2010 only)
This menu allows the user to temporarily make the ribbon disappear.  


[bookmark: _Toc318889821]Figure 24: Minimize Option on Ribbon

Click on the Up Carrot next to the Help Button. To make the ribbon reappear, click on the down carrot.


[bookmark: _Toc318889822]Figure 25: Maximize Option on Ribbon

Quick Options 
Not really a menu, but a quick and useful way to make a couple common changes, like setting the zoom or changing the page, or set information about a selection.  In this case, seven of the cells selected are filled and the numbers they contain sum to 21 and average 3.  These latter functions only work when numbers are entered into the cells, but the count feature works with all types of data.  


[bookmark: _Toc318889823]Figure 26: Quick Options View

[bookmark: _Toc274226492][bookmark: _Toc318889783]Entering and Editing Data

Cell data
Things that can be entered into a cell: 
numbers 
words 
equations, formulas, or functions 
fill color 
images (although they are actually on top of a cell, not in it) 

Entering data
Move to the cell where you want to enter data, and enter words or numbers.  If data is already in the cell, it will be replaced without your having to cut or delete the previous data.

Format data using Menus 
Once information has been entered into a cell, you might want to change something about the way the information is displayed.  For instance, you may want to limit the decimal places displayed in a cell containing a number.  To change the format of the number, select the cell containing the number and go to the Home tab.  Select the Number module and click on the Increase Decimal button.  


The process works the same for adding a dollar sign, changing a decimal to percent notation, or adding a comma separator.



Format data using a drop-down
Another option would be to click on the cell and right click, which bring up the mini formatting toolbar and the drop-down list of the most common operations.  In this case, we would select the Format Cells option.

[bookmark: _Toc318889824]Figure 27: Format Cells Menu

Once in the Format Cells menus, select the Number tab, and select the appropriate number of Decimal Places from the dropdown list.  Once again, the process would be similar for most cell formatting operations, including text alignment, changing the font style and size, adding a border, or filling the cell.


[bookmark: _Toc318889825]Figure 28: Format Cells- Number Options
Editing Using the Formula Bar
If incorrect information has been entered into a cell, one easy way to edit the cell contents is to simply click on the cell and enter the correct information.  You do not need to highlight or delete.  Typing replaces whatever is in the cell.

[bookmark: _Toc318889826]Figure 29: Using the Formula Bar to Enter/Edit Cells
If you do not want to replace the data but simply need to correct some part of it, then move your cursor into the Formula bar, which will display the contents of the cell.

[bookmark: _Toc179803620]When your cursor turns into an I-Beam, click and edit within the formula bar.  This is especially helpful for editing long strings of text or formulas.



[bookmark: _Toc274226493][bookmark: _Toc318888254][bookmark: _Toc318889784]Cell References
Review Basic References
There are several types of basic references, covering single cells, ranges of cells, row & columns references, and ranges of cells or columns.

[bookmark: _Toc318889827]Figure 30: Cell Reference Terminology
Absolute and Mixed References 
When moving or filling data, Excel often automatically changes a cell reference to match its new relative position.  For example, as shown below, copying the contents of cell B1 and pasting it into cell B3 will change the reference from A1 to A3.   

 

This is helpful in some cases, but in others it is not.  Excel allows users to control this effect by using absolute and mixed references.  These are created by placing a $ before the column letter and/or row number.  Using the same operation as above with an absolute reference for the row would keep the new formula in B3 referenced to A1.

 
[bookmark: _Toc318889735][bookmark: _Toc318889828]Figure 31: Absolute References

External References
Excel allow users to not only link to data within the current sheet, but to data in other sheets or other workbooks.  The easiest way to see this is by selecting a cell in the current workbook, typing an equal sign, and, without clicking off the destination cell, tabbing to the source worksheet, and clicking on the appropriate cell in that workbook.  Assuming the cell you want to link to is Cell A1 in Sheet 1, the reference would appear as below.


[bookmark: _Toc318889829]Figure 32: Using Formulas to Link Worksheets

Advanced users may find it more efficient to type in the formula directly, but for novice users, this method prevents most problems.  Additionally, users of all levels may find it useful to add an absolute reference to an external reference, if the data is not meant to change when filled or moved.

[bookmark: _Toc274226494][bookmark: _Toc318888255][bookmark: _Toc318889785]Fill Command & Patterns
[bookmark: fill]Using Auto Fill 
If there is a pattern in the data you are going to enter, Excel can often detect the pattern and fill it in for you.
 1
2




In Cell B1, type Group 1. 



Place the cursor on the bottom right of cell B1, and a black plus sign appears.  Click and drag to the right to cell E1.  Excel detects the pattern and fills in the other groups. 



[bookmark: _Toc318889830]Figure 33: Using Auto Fill
The image above illustrates some other patterns and a potential problem with this feature.  In row 4, the Auto Fill feature did not work because there are too many possibilities; Excel couldn’t recognize the intended pattern.  

[bookmark: autosum][bookmark: _Toc179803621]For Excel to recognize the pattern, you would have to skip to cell C5, and type a 2.  You should then highlight the cells B5 and C5 to “teach” Excel the pattern.  Now that Excel knows the pattern, the Auto Fill feature will work, and you can simply click and drag to the right to auto fill the rest of the cells. 

[bookmark: _Toc274226495][bookmark: _Toc318888256][bookmark: _Toc318889786]Using Basic Functions
Enter data
One of the principal reasons for using a spreadsheet is to perform calculations.  To illustrate, begin by adding a column of numbers.  This is from a class survey about the favorite ice cream flavor of a class.  

Caution: If you plan to ask Excel to add a column of numbers, make sure that they are numbers.  If cell B2 contained "6 students" rather than just the number 6, Excel would read the entry as a word, not a number. 


[bookmark: _Toc318889831]Figure 34: Using Excel to perform Calculations


Placing a function
In the example above, the total of the column of numbers would naturally go in cell B10.  Before placing a function (a built in equation) make sure the selected cell is where you want the function to go.

From the Formula menu select the AutoSum function and click on Sum.

[bookmark: _Toc318889832]Figure 35: Placing a formula
Using another function
Excel has many built-in equations (functions).  One more will be used as an illustration.

Once you know how to write your own functions (next topic), Excel can be used as a substitute for a calculator.  Before building functions, note another Paste function to create a cell within the worksheet that will automatically remind you of today’s date.


Cell C2 is where a Date & Time function will be placed.  From the Formula menu, select Date & Time, and then select the Today function.  The following menu will appear.

[bookmark: _Toc318889833]Figure 36: Using a Formula to Set Date & Time
Click OK and the following formula should be entered into the cell.  Click on the cell and look at the formula bar, or double click on the cell to open it for editing.

Explore
Look through the Function Library to discover what equations are built into Excel.  For most users, every imaginable data operation is probably in the library, ranging from mathematics, logical operators, scientific calculations, engineering calculations, and more.  Once you are familiar with the formulas, you can type them directly into the worksheet to save time.

[bookmark: _Toc179803622][bookmark: _Toc274226496][bookmark: _Toc318888257][bookmark: _Toc318889787]Using Equations
Preparing to enter an equation
Functions are an easy way to complete simple calculations, but at some point you will need to build your own equations.  There is a single keystroke that informs Excel of your intention.  Press the equal key (=).  

If you can write the equation, Excel can perform the calculation.  This module will deal with four simple functions: add, subtract, multiply, and divide. 


[bookmark: _Toc318889834]Figure 37: Using Excel to Add, Subtract, Multiple, and Divide
Writing an addition equation
If you were to state the process for adding the numbers in column B, then it would be "six plus three.”  The equation could be written exactly like that (=6+3), and Excel would display the expected answer, 9.  However, that equation would be useless if the numbers in either B2 or B3 were changed.  To avoid this, you should use cell addresses when writing your own equations.

=B2+B3 

[bookmark: _Toc318889835]Figure 38: Inputting an Addition Formula
When writing the equation, clicking in cell B2 displays B2 in the equation. If you have written the equation correctly, then you may accept it by pressing the Enter/Return key or by clicking on the green check mark.  If you change your mind, click on the red X to cancel the operation.

Writing other simple functions
Symbols for the four basic mathematical functions are:
addition + 
subtraction - 
multiplication * 
division / 

Task
Prepare a worksheet with the data displayed at the beginning of this section.  Enter the proper equation under each set of two numbers. 
 
Compare 
Compare your results to those shown below:
	
	
	
	
	
	
	


[bookmark: _Toc179803623]
[bookmark: _Toc274226497][bookmark: _Toc318888258][bookmark: _Toc318889788]Calculating Percent and Using Absolute Cell Reference
Review percent
Before showing how to calculate percent with Excel, let’s review how to calculate percent. 

A number divided by a second number and multiplied by 100 expresses what percent the first number is of the second number.  If you do not multiply by 100, then you have the decimal equivalent of percent.

Writing a percent equation for only two numbers
Solve the following: 2 is what percent of 8?

Now that you are sure you remember the process for calculating percent, use an Excel worksheet to perform the calculations.

[bookmark: _Toc318889836]Figure 39: Calculating a Percent

Writing a percent equation for a column of numbers accompanied by a sum
Data from the ice cream survey will be used to illustrate how to calculate percent.



Auto Fill and problems associated with it
You probably remember a discussion of Auto Fill from the previous module.  Auto Fill is a convenient way to place information in several cells at the same time.  Although Auto Fill may seem like a good way to fill the equation into cells C3 through C9, it actually will cause errors in your equation, as illustrated below. 

[bookmark: _Toc318889837]Figure 40: Auto Fill Error in Calculating Percents

Oops!  Something is wrong there.  The problem was caused by the way the equation was written.  The equation B2/B10 says, "Take the first cell in this equation and divide it by the cell eight spaces below.”  The reason that none of the other equations work is that there is nothing in the cell eight spaces below any of the cells from B3 to B10.  You must find a way of telling Excel to use cell B10 to divide by for each of the other eight equations.

Absolute Cell Reference 
You tell Excel to use one specific cell and never move to another relative location in the calculations by using "absolute cell reference.”  To specify the cell, place a dollar sign before the column letter and before the row number.  Thus, “$B$10” says always use cell B10.  Go back to the worksheet and rewrite the equation in C2.

[bookmark: _Toc318889838]Figure 41: Using Absolute References to Calculate Percents
Notice the answer has not changed.  If you were writing only this one equation, you wasted time using absolute cell reference.  The real benefit of this equation will be seen when you auto-fill down into cells C3 through C10.

Fill the equation down into the cells below
As soon as you auto-fill this equation with an absolute cell reference down into cells C3 through C10, the percentages are instantly calculated.  Only one more task remains.

[image: ex_all_cells_absref]
[bookmark: _Toc318889839]Figure 42: Using Auto Fill with Absolute References
Format the cells
Unless you need five decimal places, you should format cells C2 through C10, the highlighted range above, so that only one decimal place is displayed.
[image: ]1



Right-click on the highlighted range of cells, and select Format Cells... 
[image: ]2
3
4


In the category list, select Number.
In the Decimal places box, use the down arrow to choose 1. 
Click OK.  Now your column of data has a nice, uniform appearance.
[image: ex_uniform_format]

[bookmark: _Toc179803627][bookmark: _Toc274226498]

[bookmark: _Toc318888259][bookmark: _Toc318889789]Inserting and Deleting Rows in a Data Set 
Sometimes it is necessary to insert or delete rows from a set of data.  For instance, you might need to insert sales data for Los Angeles into the data below.  Assume you have three recent sales for Los Angeles that need to be entered into the data.  Begin by selecting three rows at the location where you would like the data to reside.  Since you would like the data to be after Denver and before New York, select rows 7 through 9. 

[image: ]
[bookmark: _Toc318889840]Figure 43: Inserting and Deleting Rows in a Data Set

[bookmark: InsertRows]To insert multiple rows, select the rows above which you want to insert rows.  Select the same number of rows as you want to insert.  For example, to insert three new rows, you select three rows.  (To insert nonadjacent rows, hold down CTRL while you select nonadjacent rows.)

On the Home tab, in the Cells group, click the arrow next to Insert, and then click Insert Sheet Rows. 
[image: Excel Ribbon Image]
[bookmark: _Toc318889841]Figure 44: Using the Home Tab to Insert Sheet Rows

You can also right-click the selected rows and then click Insert.

When you insert rows on your worksheet, all references that are affected by the insertion adjust accordingly, whether they are relative or absolute cell references.  The same behavior applies to deleting rows, except when a deleted cell is directly referenced by a formula. 

The process for inserting columns is perfectly analogous, except for clicking Insert Sheet Columns at the end.



[bookmark: _Toc274226499][bookmark: _Toc318888260][bookmark: _Toc318889790]Cutting and Pasting in Excel

Cut and Copy
One of the most common operations you will perform in Excel is cutting and copying data.  Cut removes the data and places it in another cell, sheet, or workbook.  Copy makes a copy that can be placed somewhere else, leaving the original intact.  Several methods are available to accomplish these tasks.  For example, once data is selected, it can be copied onto the clipboard by

Selecting the Copy button under the Home menu
Right-clicking and selecting Copy
Pushing the CTRL and C keys simultaneously
 
[image: ]
[bookmark: _Toc318889842]Figure 45: Copying Options

Paste data
Data that has been cut or copied must be pasted into a new location.  This can be another cell in Excel or in almost every other program, from Word to Lotus Notes.  A simple paste brings the data, along with any formatting and formulas associated with the cell. 
[image: ]
[bookmark: _Toc318889843]Figure 46: Paste Options

Paste Special
In some cases, pasting everything associated with a cell, chart, or object is not desirable.  For example, you may not want data to carry its source formatting or you may want a chart to appear as a bitmap to make it easier to view.  In those cases, you would use the Paste Special option that can be found by right-clicking into the destination cell or in the Home menu under the Paste drop-down.  

[image: ]
[bookmark: _Toc318889844]Figure 47: Paste Special Options

[bookmark: _Toc274226500]

[bookmark: _Toc318888261][bookmark: _Toc318889791]Creating Static Charts in Excel

Selecting Data and Chart Type
Besides computation, one of the most common uses of Excel is to create static charts to help analyze a set of data.  The first step in this process is always selecting what data you want to analyze and what type of chart to use.  Selecting the type of chart is as much art as science, and some trial and error may be necessary before you find one you like.

The most common types are shown under the Insert tab in the Chart area.  For each type, there are numerous sub-types, each with a slightly different look. 

[image: ]

[image: ]

[bookmark: _Toc318889845]Figure 48: Excel Chart Types



Basic Chart
Once a chart type is chosen, Excel will display the chart and the three Chart Tools menus

[image: ]
[bookmark: _Toc318889846]Figure 49: Chart Tools


Menu Options
The primary method for customizing and modifying charts in Excel 2007/10 is through the three chart menus.

Design – Allows you to quickly swap chart types (e.g., column to pie), edit the data source, choose among popular layout styles, and change the chart colors.

[image: ]
[bookmark: _Toc318889847]Figure 50: Chart Tools- Design



Layout – Allows you to add extras like text boxes and pictures, add and edit the various chart elements (title, axis, gridlines, plot area)

[image: ]
[bookmark: _Toc318889848]Figure 51: Chart Tools- Layout

Format – The primary way to edit the look of the chart, including the color scheme, text effects, chart area size, and alignment.
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[bookmark: _Toc318889849]Figure 52: Chart Options- Format

Manual Formatting
By right clicking on the various parts of the chart, you can also modify and customize in a more manual fashion, as was possible in earlier versions of Excel.

By clicking on the chart area (the space around the plot area), you can access many features, such as changing chart types and reselecting data, as well as open the mini format toolbar and Format Chart Area menu.
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[bookmark: _Toc318889850]Figure 53: Manually Formatting Charts

The Format Chart Area menu allows you to modify all of the formatting of the chart area, including fill style, border, and shadowing of the chart area.  If this menu is open, you can open related menus for formatting the other elements for a chart (data series, gridlines, axis) simply by clicking on one of those elements. 

[image: ]
[bookmark: _Toc318889851]Figure 54: Format Chart Area Menu
Additionally, right-clicking within the Plot Area, Gridlines, Title, Legend, Axis, or Data Series opens similar sets of options, including opening the format menu specifically tailored to each element. 
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Analytical features, such as trend lines and error bars, can also be formatted in this manner if necessary, or they can be formatted using the applicable Format menu.

[image: ]
[bookmark: _Toc318889852]Figure 55: Formatting Trendlines
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[bookmark: _Toc318889794]Microsoft Excel: Sorting, Filtering, and Pivot Tables
[bookmark: _Toc179803629][bookmark: _Toc274226502][bookmark: _Toc318888265][bookmark: _Toc318889795]Introduction to Sorting
The records that make up a data set can be rearranged by changing the field by which the data set is filtered.  For example, the data set below is sorted in ascending order by the Asset Description field.
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[bookmark: _Toc318889853]Figure 56: Introduction to Sorting
[bookmark: _Toc179803630]Getting Started 
Select any cell within the data table. 
From the Data menu, select Sort.  Excel will automatically determine the data to be sorted, which should be highlighted, and a Sort dialog box will appear.  Verify that the entire data set you would like to sort is highlighted.
In the open dialog box, select the field to sort by, the type of sort and the sort order, and press OK.2
3
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[bookmark: _Toc318889854][bookmark: _Toc179803631]Figure 57: Step by Step Instructions for Sorting Data
Sorting Data based on a Single Field
[bookmark: _Toc179803632]The Sort dialog box allows data to be sorted by as many fields as you have data columns—each of which may be sorted in ascending or descending order.  The result of sorting the Asset Code field in ascending order is shown below. 
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[bookmark: _Toc179803635]Sorting Data based on Multiple Fields 
[bookmark: _Toc179803636]A similar approach is used when sorting data using multiple fields.
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[bookmark: _Toc318889855]Figure 58: Sorting Data Using Multiple Fields
In this example, the Asset Code field is sorted in ascending order.
Then the API field is sorted in ascending order. 

The result of this sort is shown below.  Note that the sorting of the Asset Code field took precedence over the sorting of the API field.  As a result, the records are first grouped together by their Asset Code, and then, within each of these groups, the records are sorted in descending order by API.
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[bookmark: _Toc318889856]Figure 59: Sorted Data Using Multiple Fields
[bookmark: _Toc179803637][bookmark: _Toc274226503]

[bookmark: _Toc318888266][bookmark: _Toc318889796]Introduction to Filtering
Filtering is a quick and easy way to find and work with a subset[footnoteRef:1] of a data set.  A filtered data set displays only the rows (records) that meet the criteria[footnoteRef:2] you specify for a column.  Excel provides two commands for filtering ranges: AutoFilter and Advanced Filter.  Only the AutoFilter command is covered in this document. [1:  Subset: A group of data that is part of a larger data set.]  [2:  Criteria: Conditions you specify to limit which records are included in the result set of a query or filter.] 


Unlike sorting, filtering does necessarily reorganize a data set, although the filter can be used to sort data.  In most cases, filtering temporarily hides rows you do not want displayed.  When Excel filters rows you can edit, format, chart, and print the subset of data without reorganizing or moving it.
[bookmark: _Toc179803638]
Format the Data Set

 3
4
1
2


The first row of the data set should contain headings. 
Subsequent rows should contain data, and there should be no blank rows within the data set (individual blank cells are acceptable but blank rows are not).  There should also be a blank row at the end of the data set and a blank column at the right.

[bookmark: _Toc179803639]Turn on the AutoFilter

 

After selecting any cell in the table, go to the Data menu and choose Filter. 
A dropdown arrow  appears to the right of each column heading, indicating that each column heading is now a label in the filtered range. 

[bookmark: _Toc179803640]Filtering the Data based on a Single Field
5
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To filter the list, select the dropdown arrow for the field that you would like to filter and choose an item from the list. 
For example, if you were only interested in the 1100 assets, you would select 1100 from the Asset Code dropdown list.

 

Once you select 1100 from the list, the dropdown list disappears, and the table only reflects the data for 1100.  Rows that do not meet the criteria are hidden.

[bookmark: _Toc179803643]

Filtering the Data based on Custom Criteria
By default, when you select an item from the dropdown list, the list is filtered for rows that are equal to the item that you chose. 
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[bookmark: _Toc318889857]Figure 60: Filtering Data Using Custom Filters

If you need more options when filtering, choose Custom Filter from the dropdown list. 
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[bookmark: _Toc318889858]Figure 61: Custom Filter Dialog Box

The Custom AutoFilter dialog box will appear.  This Custom AutoFilter dialog box can be used to filter the list based on multiple conditions. 
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[bookmark: _Toc318889859]Figure 62: Custom AutoFilter Parameters
If you wanted to see CRVs between $400,000 and $800,000, you would select is greater than or equal to from the Show rows where dropdown list and enter $400,000 (or select $400,000 from the dropdown list). 

[image: ]

You would then select is less than or equal to and enter $800,000 (or select $800,000 from the dropdown list). 
Once you have completed all the information in the dialog box, select OK.

[bookmark: _Toc179803644][bookmark: _Toc274226504]

[bookmark: _Toc318888267][bookmark: _Toc318889797]Introduction to Pivot Charts & Tables
A pivot chart is a type of worksheet that, using data from one sheet, transposes only selected data to a table on a new worksheet for easier viewing.  This section will demonstrate how to transform a large data set into a summary table.

[bookmark: _Toc179803645]Getting Started1
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[bookmark: _Toc318889860]Figure 63: Inserting a PivotTable and PivotChart

Click on the Insert menu.
Select PivotTable and PivotChart. 

A PivotTable and PivotChart Wizard dialog box will appear. 

 [image: ]
[bookmark: _Toc318889861]Figure 64: Create a PivotTable Dialogue Box

Select the Range of data that you would like to summarize using the PivotTable.  The Range may automatically populate.  In this case, verify that Excel auto-populated the correct range of data.  The selected data range will be outlined with a dashed line. 
For the final step of the wizard, select where you would like to put the PivotTable report. The default is to put the report on a New Worksheet. 
Select OK. 

[bookmark: _Toc179803646]Setting up a PivotTable Chart
Once the wizard is complete, a worksheet is created with a blank PivotTable and PivotChart.  A PivotTable Field List will also be displayed, as shown below.  The items in the PivotTable Field List represent each column of data from the data set.  These fields can be placed in the row, column, data, or page fields of the blank PivotTable. 
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[bookmark: _Toc318889862]Figure 65: PivotTable Field List

If you want to see the sum of the CRV for all assets, you would select the CRV field from the PivotTable Field List.
Hold the left mouse button down and drag the field into the Data Field of the PivotTable.  The PivotTable will refresh to reflect the count of all the CRV, which is the typical default.



Excel will automatically create a chart of the data.  In this case, it is simply charting the total number of CRV values, but the chart will change as changes are made to the Pivot Table.
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[bookmark: _Toc318889863]Figure 66: Using a PivotTable to Create a PivotChart

You can change the way that the data is summarized by right-clicking the data field. Select Value Field Settings from the menu and a PivotTable Field dialog box will appear.  This allows you to change how the data is summarized. 
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[bookmark: _Toc318889864]Figure 67: PivotTable Value Field Settings

To see the sum of all CRV for this data set, you can select Sum from the Summarize by dropdown list. 
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[bookmark: _Toc318889865]Figure 68: PivotTable Value Field Settings- Summarize by

To see the CRV by Asset Code, drag the Asset Code field from the PivotTable Field List to the Row Labels Field
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[bookmark: _Toc318889866]Figure 69: Pivo